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1 Introduction

About this Guide

This Guide explains how to use the Vicomsoft DHCP Server to provide dynamic IP addressing
to your Local Area Network.

It includes information on the following:

• System and network requirements
• Installing and configuring the DHCP Server
• Configuring client computers on the Local Area Network
• Operating and customizing the DHCP Server
• DHCP Questions & Answers

What is the Vicomsoft DHCP Server ?

DHCP stands for Dynamic Host Configuration Protocol and allows client machines to obtain
their TCP/IP network configuration information from the Vicomsoft DHCP Server
automatically, instead of requiring manual set-up. This reduces the work required to set-up
client machines and reduces the likelihood of user errors.

The Vicomsoft DHCP Server provides this configuration service for Windows, UNIX and Apple
Open Transport and MacTCP clients, attached to the Vicomsoft DHCP Server. No special client
software required.

How does the DHCP Server Operate ?

The Vicomsoft DHCP Server can hand out up to 1024 simultaneous client addresses. DHCP
clients are issued with addresses on one hour lease (by default), renewable during the lease
period. BOOTP clients are issued addresses indefinitely.

When a client needs to start up TCP/IP operations, it broadcasts a request for address
information. The DHCP Server assigns a new address and sends it to the client together with
the address of its default gateway, the subnet mask and the domain name server address
configured in the Server. A WINS Server address can also be sent to Windows clients. This
information is acknowledged by the client and used to set up its configuration.

The DHCP Server calculates a default dynamic address range. The default behaviour is as
follows:

The Server uses the lowest 100 (or all) addresses in the subnet range BELOW the Server's own
address. So, by selecting a suitable address, the subnet address range can be split into static and
dynamic ranges automatically.
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For some network systems it will be unnecessary to modify the defaults. The dynamic address
ranges can be edited and augmented by the user. The “Network” Menu item "DHCP Set-up…"
opens a list of the current address ranges. The "New Range" and "Delete Range" buttons can be
used to change them. Served address ranges need not be constrained to the directly connected
networks if suitable BOOTP relay agents exist in the routing system.

The Vicomsoft DHCP Server runs on any Mac OS compatible system with the following
minimum specifications:

• A Macintosh or Mac OS compatible PowerPC, G3, G4, iMac.
• System Software version 7.6.1 (We recommend 8.0).
• Open Transport version 1.1.1 or higher.
• At least 6 MBytes available memory.
• Up to 5 MBytes of available disk space.

With any Mac OS version below 8.0, you should use Open Transport version 1.1.2.

Please note that the Vicomsoft DHCP Server is a TCP/IP Application, TCP/IP networking can
be a complex subject. We do expect a basic knowledge of TCP/IP and networking, and this User
Guide has been written in an attempt to describe things at a Basic level. If you are not familiar
with TCP/IP routing concepts, we recommend these books if you are new to networking and
TCP/IP. Networking for Dummies 3rd Ed. published by IDG, ISBN 0764503464, and TCP/IP for
Dummies, published by IDG, ISBN 0764504738.
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2 Installing the DHCP Server

Installing the DHCP Server

Downloaded InstallationIf you have purchased using the Online delivery system, it is very
important that you make a backup of the files you download, the emails you receive and the
license file. This is required in case you need to re-install the Server at a later date.

To install the DHCP Server, double-click on the “Install DHCP Server” icon. After an
introductory screen, the following window is displayed:

Drag the Vicomsoft DHCP Server icon to your Startup Disk on the right. This will create a
folder on the disk called “Vicomsoft DHCP Server”.

The following files are installed into there respective folders:

DHCP Server folder

• The DHCP Server application.
• The Local Administrator application.
• One or more ReadMe files providing supplementary information about the version

you have installed.

Installed with the DHCP Server are:

Extensions folder

• “-Gateway-”— Extension enabling TCP/IP client or server applications to be used on
the DHCP Server computer.

• “Vicomsoft System menu”— Extension enabling a menu option to allow you to control
the DHCP Server without loading the user interface.

Preferences folder

• A VICOM Settings folder which includes the DHCP Clients file.
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Purchase Product Online

To purchase the Vicomsoft DHCP Server simply select the ‘Purchase’ option in the “Network”
menu, and this window will be displayed. Please note that you will need to be able to connect to
the Internet from this machine.

When you click on the Purchase button the Vicomsoft DHCP Server will open your Web Browser
and you will be taken to the Vicomsoft e-Commerce Store.

Once you have entered all your details in regards to your purchase the following will occur.

• You will receive an email containing a License file attachment and URL where you
can download your newly purchased Vicomsoft DHCP Server. Full instructions are
contained in this email.

You Must keep a copy of the email, the downloaded file and the license file in case you are
require a re-install. If you do not make a copy of the software and e-mail, you Will be charged
for replacement copies.
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3 The Open Transport IP
Address

 About this Chapter

It is possible to run TCP/IP applications such as a web browser, email client or even a mail or
web server on the DHCP Server computer. However, since the DHCP Server is handling all IP
packets, data sent or received by the application must pass through the DHCP Server rather
than Open Transport.

During installation, the DHCP Server places a Open Transport driver file called “-Gateway-”
in your Extensions folder. When set to use this driver, Open Transport will send and receive all
data through the DHCP Server.

Open Transport must always have an IP address, because of this the DHCP Server selects one of

its ports and ‘attaches’ TCP/IP to that port. The DHCP Server will mark this port with a 
icon in the status window ports list. The DHCP Server computer then assumes the IP address of
that port and will automatically configure your TCP/IP control panel to allow this to happen.

You can change the ‘attached’ port (known as the Mac Port) by highlighting the new port you
wish to attach TCP/IP to and then select “Change this Mac’s TCP/IP Address...” from the
“Ports” menu. Note that you should quit any currently running TCP/IP applications before doing
this.

You must also set up a default router address to enable TCP/IP applications to reach remote
networks and the Internet. Enter the address of the default router in the "Network" tab of the
Preferences window.
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4 Configuring the DHCP Server

 About this Chapter

The DHCP Server works on the idea of ports. Each port that you create is used to assign IP
address to a network. Each port must have an IP address, a Subnet mask and a Router Address to
be assigned to the clients on your network.

Setting up the Vicomsoft DHCP Server

You can add new ports, by selecting “New Port”, in the “Ports” menu. You can also manually Edit
Ports by double-clicking the port in the DHCP Server status window or by highlighting the
port you wish to edit and selecting “Edit Port” from the “Ports” menu. The Edit Port settings
window will appear:

Port Name: If you type a name into this field it will be shown in the Ports list in the DHCP
Server status window, otherwise a default name will be used.

Connection

Using: This will display the interface that you are using for this port.

• Built In: This is what will be displayed if you select the Built in Ethernet device,
or the correct card slot if you select an ethernet card from one of the slots.

Network Properties

IP Address: The Local network Port must always have a static IP Address. DHCP Server
default IP address is 192.168.181.254. You can change this if your DHCP Server system is
connected to an existing local TCP/IP network with a different address range.

Subnet Mask: Allows you to set the subnet mask for the entered IP address, the default subnet
mask will be 255.255.255.0.

Router Address for Automatic Range: This is the address the DHCP Server will send to clients
so the clients know where to route TCP/IP Traffic.



Chapter 4. Vicomsoft
Configuring the DHCP Server DHCP Server

7

View DHCP Clients

During DHCP Server operation, the DHCP Server’s current list of assigned addresses and active
clients can be displayed by selecting “View Users” in the “File” menu.

The list shows the following items;

Computer & User Name: The names displayed within this section are as defined within the
DHCP Client file, for more details see ‘The DHCP Server’ chapter. They can be as set within
the Network Identification settings on the client system. This will also display the name as
entered within the local access console.

IP Address: The IP address of the client computer.

Services: Displays the services in use by that user. The Services that will be displayed can be
one or a combination of the following:

(D) DHCP (B) BOOTP (A) Administrator

DHCP Time Left: The lease time remaining for the DHCP served address.

Hardware Address: This is the unique hardware address of the client's network interface
adapter card.

The options available in the “View Users” window are;

Display: Allows you to hide or show a column displayed in the Users View by selecting the
view you wish to hide or show.

Snapshot DHCP clients: This option provides you with the ability to create a snapshot of the
currently listed DHCP clients as viewed within the View Users display. A DHCP Clients file
is created with the the displayed information. For more information about the DHCP Clients
file, and using the Snapshot option, please see the ‘The DHCP Server’ chapter.

You can hide or show a column displayed in the Users View by selecting the column to hide or
show from the drop down menu.

A client machine can override any name given to it in the DHCP Clients file by sending its name
to the DHCP Server when requesting an IP address.
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5 Running the Vicomsoft
DHCP Server

 About this Chapter

This Chapter describes the facilities for monitoring and controlling the DHCP Server. These
include the menu bar icon, the menus, controls and status displays presented in the window.

The DHCP Server also supports AppleScript, for certain items. For a full AppleScript
dictionary see Appendix A, AppleScript Commands.

Starting and Stopping the DHCP Server

The DHCP Server is started and stopped by any of the following methods.

• Click on the On/Off Switch in the Status Window.

• Select Start DHCP Server /Stop DHCP Server from the “Network” menu.
• Keyboard Shortcut (Control & G).
• Select Start DHCP Server/Stop DHCP Server from the DHCP Server menu bar icon.

The DHCP Server's Preferences can be set so that when the application is launched, it turns
itself on. The DHCP Server can be launched when the computer is switched on by copying an
alias into the Startup Items folder of the System folder. To make sure that the DHCP Server is
the first application to launch, insert a space before the name of the alias.
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The DHCP Server Menus

The DHCP Server's facilities are accessed through its menus. The menus are listed below as
they will be seen and in the order that they are displayed.

File

Save Config As...
Hide DHCP Server Status
View Users...
User Account Setup...
Lock User Interface
Quit

Edit

Preferences

Network

Purchase
Check for Updates
Start/Stop DHCP Server
Routing Tables...
DHCP Setup...

Ports

New Port...
Edit Port...
Delete Port
Stop/Start Port
Reset Port
Start Tracing Port
Trace TCP/IP Packets...
Change this Macs TCP/IP Address
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The DHCP Server Status Window

The DHCP Server Status window shows the current activity of the DHCP Server and the status
of all the ports. The DHCP Server status window looks like this:

Items in the status window have the following functions:

On/Off Switch: Turns the DHCP Server on or off.
Clients: Displays the current number of IP address assigned.
Port List: Name, Type, IP address and  status of each port.
User Counter: The total  number of IP Addresses that can be assigned.
DHCP Messages: The current operating state of the DHCP  Server.

The DHCP Server status can be resized by click dragging the bottom right of the window.

The Port List Display

If the Port List is not visible within the Status window, click and drag down on the bottom right
of the window to show it.The order of the ports can be adjusted by clicking and dragging. A
typical Port list display is shown below;

Port

If there is a problem with a port, an exclamation mark is displayed next to its icon under the
Port Type heading.

This icon next to a port tells you the IP address of the
Vicomsoft DHCP Server computer.

The Port name is either a default name corresponding to its connection method or a name you
enter in the Edit Port Settings window, details provided in the ‘Customizing the Vicomsoft
DHCP Server’ chapter.

Address

The IP address of each port is displayed.

Status

The port message indicates connection status. If the port has been disabled for any reason, an
error message is displayed here.
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DHCP Server Preferences

This section describes the facilities for changing the DHCP Server preferences.

To open the DHCP Server Preferences window, select Preferences from the “Edit” pull-down
menu.

General

Launch & Quit

Inactive at Application Launch: When selected, DHCP Server will not start to provide any
TCP/IP Addresses until it has been manually switched On.

Active at Application Launch: When selected, DHCP Server will provide TCP/IP Addresses as
soon as the application is launched.

Set TCP/IP on this Mac to use the DHCP Server on Launch: When selected, the DHCP Server
will automatically configure Open Transport to use one of its port addresses whenever the
DHCP Server application is launched. See Chapter 3 for more details on choosing the port
address. It creates a configuration in your TCP/IP control panel called VICOM. We recommend
users should leave this option switched on unless they know of a configuration which does not
require it. If this option is switched off you must manually configure the TCP/IP control panel.

Ask For Confirmation Before Quitting: When selected, the DHCP Server prompts the user for
confirmation before quitting if the DHCP Server is switched on. This stops users from
accidentally quitting the DHCP Server when it may be in use by other people. The confirmation
prompt will time out after 30 seconds and the DHCP Server will quit.

Show User Interface When Server Application Launches: When selected, the Local
Administrator user interface will be displayed when the DHCP Server is launched.

Quit Server When Interface Quits: When selected, the DHCP Server will quit when the user
interface quits.
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Network

Addresses

Default Gateway Address: This is the address the Vicomsoft DHCP Server will send packets to
when it knows no explicit route to the destination address.

DNS Addresses: These may be the DNS addresses supplied by your Internet Service Provider or
a local DNS Server on your internal network. You can enter upto 5 DNS Servers to be sent to your
DHCP Clients.

WINS Address: The DHCP server can also serve the address of a WINS server, if you have one.

Default Domain Name: Enter your own Domain name here if you with this information to be
sent to your DHCP Clients.

Enable DHCP Serving: When selected, the DHCP Server is activated and will assign IP
address to client machines. Instructions on setting up the most common client operating systems
to use DHCP are provided in the Setting Up Local Clients chapter. This option should be
disabled if using a Cable or xDSL connection without a second Ethernet interface.

Only to client in the ‘DHCP clients’ file: When the option above “Enable DHCP Serving” is
selected, the DHCP Server will only assign IP addresses to clients that are listed within
the DHCP Clients file. Please see the ‘The DHCP Server’ chapter for more details about
the DHCP Clients file.

The above option is only selectable when the ‘Enable DHCP Serving’ option is selected.
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Security

Set Administrator Password: Adding password protection prevents inadvertent or unauthorized
modification of the DHCP Server configuration. When an Administration password is set, any
attempt to change the DHCP Server’s operational state will be intercepted with a password
challenge. Activity status can still be viewed even when a password has been set.

To remove the administration password, leave blank entries in both edit boxes.

Administrator Lock Timeout: This is the length of time the User Interface will stay unlocked.
The time starts after you have entered the password and activity has stopped. Once this time
has passed you will need to enter the password before you can edit any of the settings.

The password control will not take effect until after the current management session has been
closed or “Lock User Interface” has been selected from the ‘File’ menu.

User Administration Option

Allow User Login: Selecting this option allows you to connect from a remote computer. Any
valid user, entered with the the User Account Setup, can connect the Vicomsoft DHCP Server
from any IP address.
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Customizing the DHCP Server

When it starts, the DHCP Server operates in its default mode. You can change its settings by
selecting “DHCP Setup” from the “Network” menu, you must be in Advanced User Mode. You
will then be able to adjust the maximum number of addresses the server will assign, the ranges
of addresses it can distribute and the lease time for DHCP assignments.

The server can assign up to 100 simultaneous client addresses in its default configuration. This
limit can be adjusted up to a maximum of 1023 in the Maximum clients box.

Automatic Ranges: When enabled the DHCP Server will create a range automatically using
the IP address you assigned to the Port. Starting from the lowest number and working to wards
the total number of Maximum clients or the highest number available.

Check If Address is Already In Use: When enabled the DHCP Server will PING the IP address
it is about to assign to see if it is currently in use.

Disable BootP Serving: When selected the DHCP Server will not respond to any BootP requests.

Lease time: This is the amount of time that each IP address will be leased to a client or until a
client requests a renew of this time.

Maximum Clients: The maximum number of clients you want the DHCP Server to assign.

Boot Server IP Address: This allows you to enter the IP address of a Server for network booting
clients.

Boot File Name: This option allow your to enter the Boot file for those network boot clients.

DHCP clients are issued with addresses on a limited lease and they can renew at any time
during this period. The default DHCP lease time of 60 minutes can be modified in the Lease
Time box. BOOTP clients are assigned addresses indefinitely.
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Each Ethernet port has a separate “Enable DHCP” Check-box which can be accessed in its Edit
Port Settings window, for more information please see the ‘Customizing the Vicomsoft DHCP
Server’ chapter. It is therefore possible to define which of the directly-connected LANs the
DHCP Server will accept DHCP requests from. This is especially important if you are using a
cable or xDSL modem on one Ethernet device and your LAN is networked together via a
separate Ethernet card.

When a client needs to start up TCP/IP operations, it broadcasts a request for address
information. The DHCP Server assigns an IP address and sends it to the client together with
the subnet mask, a Router address and the domain name server address information. This
information is acknowledged by the client and used to set up its configuration.

When the DHCP lease time reaches half way for a client, the client will ask the DHCP server
if it can re-new or still use the IP address. If so the DHCP lease time will be reset.

The DHCP Server calculates a default dynamic address range for each configured Ethernet
port. The default number of IP addresses to assign is 100, the default DHCP lease time is 60
minutes. The default behaviour is as follows:

The server assigns addresses in each Port’s subnet range starting at host address zero. It assigns
increasing host numbers up to a maximum of one less than its own port address. So, by selecting a
suitable port address, i.e. 192.168.181.254, you can serve 253 addresses.

For most network systems it will be unnecessary to modify the defaults, but if necessary, the
dynamic address ranges can be edited and augmented by the user. Turn of automatic ranges and
then select the “New Range” you can then enter your own range. The “Delete Range” button will
delete a selected, range. Served address ranges need not be constrained to the directly connected
networks if suitable BOOTP relay agents exist in the routing system.

DHCP Clients File

A text file called “DHCP Clients” is put in the “VICOM Settings” folder (in the
System/Preferences folder) by the Installer. You can use SimpleText or other text editors to edit
this file to define fixed address assignments for specific client computers. This is useful in the
case you have any servers that must have the same address at all times. You can also use it to
assign a user or machine name to each client, making it easier to monitor which clients are
active and to trouble-shoot client problems.

The file format is:

<Media Access Control (“MAC”) Address> <TAB> <IP Address> <TAB> <Name>

For example:

08:00:54:b0:fd:36 0.0.0.0 My_dynamic_Mac
08:12:07:be:5f:72 192.168.181.120 Web_Server_fixed
03:11:0c:3e:ea:9c 192.168.181.121 Fixed_admin_PC

The MAC address is the physical address of the Ethernet or Token Ring adapter in the client
machine. (it has no direct relationship to “Macintosh”). An Ethernet address is represented as
xx:xx:xx:xx:xx:xx, where each “x” is a hexadecimal character. For example you can find the
MAC address of a Macintosh computer running Open Transport on Ethernet by opening the
AppleTalk or TCP/IP Control Panel and selecting “Get Info” in the “File” menu. In MacTCP,
hold down the Option Key while clicking the Ethernet icon to display the MAC address.



Vicomsoft Chapter 5.
DHCP Server Running the Vicomsoft DHCP Server

16

If the IP address is entered as “0.0.0.0” then the DHCP Server will assign an address
automatically. If any other valid address is entered then this will be reserved for that client
only and always assigned to it when an IP address is requested.

The Name field can be up to 16 characters, containing no spaces or tabs.

It is preferable that if you are going to assign static IP addresses by manually configuring a
client or by using the DHCP Clients file, make sure to use IP addresses outside the range set in
the DHCP Setup window.

Snapshot DHCP clients

The Snapshot option provides you with the ability to create a snapshot of the currently listed
DHCP clients as viewed within the View Users display. A DHCP Clients file is created with
the the displayed information. This option, along with the ‘Only to client in the ‘DHCP
clients’ file’ option within the Preferences will allow you to Serve DHCP on a single ethernet
connection.

To configure DHCP for a single Ethernet device, you will need to make sure that you only have
the network containing the clients that you wish to serve DHCP to connected to your Ethernet
device.

Once you have your networks seperated, make sure the Vicomsoft DHCP Server is running and
configured to serve DHCP via the correct ethernet port and device, and allow the clients to
obtain their IP addresses from the Vicomsoft DHCP Server. When all the clients are listed
within the View Users Window, right click within the Window and select Snapshot.
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Manual Routing Entries

In a routed network the DHCP Server may be required to serve addresses to clients that are not
on a directly connected LAN. In this case the LAN routers should be configured for DHCP relay,
also known as BOOTP relay. The relays will then forward the DHCP client requests to the
DHCP Server, which will send replies back through the routers. In order to do this the Server
needs a routing table that lists the router address to use for each destination network. The
routing table can be configured automatically if the LAN routers are set up to broadcast RIP
(Routing Information Protocol). Routing can also be configured manually by choosing “Routing
Tables…” from the Network pull-down. The following window will appear:

Network:  The network address of the network that is reached via this route. .

Subnet Mask: The mask to apply to the network address.

Via Gateway: The address of the router or gateway to which packets destined for this entry’s
network will be forwarded. The address entered should be that of a router which is on a
network range the Vicomsoft DHCP Server has on one of its ports.

Hop Count: The number of routers/gateways the packet of data will travel through to get to the
destination network. This should not include the Vicomsoft DHCP Server itself.
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6 Setting Up DHCP
Server Clients

 About this Chapter

Client computers must be set up so that they can obtain an IP address from the DHCP Server.
You can have any combination of Windows, UNIX, Macintosh or other TCP/IP clients.

This chapter describes how to do this for a number of common client systems.

Open Transport DHCP Client Configuration

We recommend using Open Transport 1.1.2 or later.

1. Launch the TCP/IP control panel.
2. Select Connect via: Ethernet and Configure: Using DHCP Server from the pop-up menus.

3. Close the TCP/IP control panel.
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MacTCP Dynamic Client Configuration

1. Launch the MacTCP control panel.

2. In the first window, select Ethernet for your network.
3. Click More to get to the second window.

4. Set the “Obtain Address” option to “Server”.
5. In the Domain Name Server Information field, enter a dot “.” in the Domain box and enter

your DNS address in the IP Address box.
6. Click OK, Close the control panel and Restart the computer.

On a busy network MacTCP may not pick up the IP address information sent to it by the DHCP
Server; it will therefore fail. The way to overcome this is to either set-up that computer
manually or to upgrade the computer to Open Transport.
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Setting up Windows 95/98 Clients

1. Open the Network control panel.
2. Highlight TCP/IP and click the “Properties” button.

3. Select the IP Address Tab and click “Obtain an IP address from a DHCP Server”.
4 . Select the WINS Configuration Tab and select use DHCP for WINS resolution.

(Only if Required)
5. Close the Network control panel.

Setting up Windows NT Clients

1. Open the Network control panel.
2. Highlight TCP/IP and click the “Properties” button.
3. Select the IP Address Tab and click “Obtain an IP address from a DHCP Server”.

4 . Select the WINS Address Tab and select use Enable DNS for WINS resolution.
(Only if Required)

5. Close the Network control panel.
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Setting up Windows 2000 Clients

1. Open the Network control panel.
2. Highlight TCP/IP and click the “Properties” button.

3. Select the IP Address Tab and click “Obtain an IP address Automatically”.
4. Select the IP Address Tab and click “Obtain DNS Server address Automatically”.
5. Close the Network control panel.

Setting up Windows 3.x Clients

TCP/IP setup procedures vary according to the software installed. The following is a typical
example based on Netmanage NEWT:

1. Start up the “Custom” application that is installed with NEWT.
2. Select “Configuration” in the Setup Menu and check the box for “Use Dynamic

Configuration”.
3. Check the box for “DHCP”.
4. Close the Custom application.
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7 The Vicomsoft Administrator
Console

About this Chapter

This Chapter describes the Vicomsoft Administrator Console, this can be used to manage the
Vicomsoft DHCP Server if the Remote Management option has been purchased along with the
Vicomsoft DHCP Server. If you have not purchased this option, then please disregard this
chapter.

Remote Management

The Vicomsoft DHCP Server includes an Administrator Console feature. This will allow you to
remotely change and adjust your Vicomsoft DHCP Server settings from any machine on the
Local Network or even from a location on the Internet.

The Administrator Console is contained in a separate installer, so you can install the
Administrator Console on to any machine that you may wish to control the Vicomsoft DHCP
Server from. Copies of the Vicomsoft Administrator Console can be downloaded from the
Vicomsoft web site at:

http://www.vicomsoft.us/

The Administration Console installer will install a single application called the Vicomsoft
Administrator Console. When launched you will only be presented with a “File” menu. When
you select "Connect” you will be prompted to enter the IP address of the Vicomsoft DHCP
Server and your username and password.

You will be prompted to enter the IP address of the Vicomsoft DHCP Server, your username and
password. The IP address of the Server depends on the Server’s configuration and the operating
system, Windows or Macintosh, the Server is running on.

With a Macintosh Server, Open Transport must always have an IP address, because of this the
Vicomsoft DHCP Server selects one of its ports and ‘attaches’ TCP/IP to that port. The

Vicomsoft DHCP Server will mark this port with a  icon in the status window. The
Vicomsoft DHCP Server computer then assumes the IP address of this port. The IP Address of
this port, is the IP address that Must be entered within the Address box.



Vicomsoft Chapter 7.
DHCP Server The Vicomsoft Administrator Console

23

With a Microsoft™ Windows Server, TCP/IP on the Vicomsoft DHCP Server will be configured
to an IP address in the same network range as the local ethernet port. As an example, by default
the auto setup configures the Ethernet port with 192.168.181.254 as its Ethernet Port IP address,
it will also configure TCP/IP to 192.168.181.253, to reach the Server on a Windows machine you
would use the 192.168.181.253 IP address, as this is the actual address of the Microsoft™
Windows computer.

The username and password that are expected must be those that are entered into the ‘User
Account Setup’, this option can be found in the “File” menu. You must set the Can Login option,
this option will allow the user to connect to the Vicomsoft DHCP Server. If you wish to allow
the user to have Full access to adjust all the features of the Vicomsoft DHCP Server you must
then select both Can Login and Can Manage.

When connected the Status screen for the Vicomsoft DHCP Server that you are connected to will
be displayed. This Status window shows a Windows version of the Vicomsoft Administrator
Console connecting to a Vicomsoft DHCP Server running on a Macintosh.

All the Preferences will work and be displayed as normal. Those commands that are for the
Local display only will be displayed as local options. The only Local only Options are Local
Display and Local User mode.

Managing Remote Administration Users

Selecting “User Account Setup...” from the “File” menu of the Vicomsoft DHCP Server, the
following window will be displayed.
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The list shows each user’s name, password and if they are active and the remote
administration options, Can Log in, Can Manage or Internet Filters. The Internet Filters option
is used for users connecting via the Remote control or Remote Administrator console. Users that
are not active will not be able to dial in and connect to the Vicomsoft DHCP Server or connect
remotely.

To set up a user account select “New” and enter the user's details. For more details on remote
users dialling into the Vicomsoft DHCP Server, please see the ‘Setting up Remote Access
Services’ chapter.

User Management Options

The following options are displayed in this window. With these options you can configure users
to View or Manage the Vicomsoft DHCP Server via the Vicomsoft Administrator Console, or
connect using the Remote Control application.

Can Login: This specifies if the user can connect to the Vicomsoft DHCP Server via the
Vicomsoft Administrator Console, or the Remote Control application.

Can Manage: This specifies if the user can connect and edit the Vicomsoft DHCP Server setup
via the Vicomsoft Administrator Console, or the Remote Control application.
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8 DHCP Frequently Asked
Questions

About the DHCP Q&AThe following is a reprint of the Knowledge share section on the Vicomsoft
web site http://www.vicomsoft.us/knowledge/ks.main.html.

With an increase in TCP/IP networks the ability to assign IP client configurations
automatically for a specific time period (called a lease period) has alleviated the painful
process of IP address management. Network administrators can now automate and control from a
central position the assignment of IP address configurations using the Dynamic Host Control
Protocol (DHCP).

We are presenting the information in an Q&A (Questions and Answers) format that we hope
will be useful. Our knowledge of this subject relates primarily to DHCP servers in general use,
although the information offered here should cover almost any DHCP server. We welcome
feedback and comments from any readers on the usefulness or content. Please direct such email to
feedback.vicom@vicomsoft.us

We are providing the best information available to us as at date of writing and intend to
update it at frequent intervals as things change and/or more information becomes available.
However we intend this Q&A as a guide only and recommend that users obtain specific
information to determine applicability to their specific requirements. (This is another way of
saying that we can't be held liable or responsible for the content).

The full Q&A is divided into two parts. Part one is general in nature and less technical, Part
two deals with more technical matters.

If, after reading our Q&A you have any questions we would be pleased to try to answer them.
Questions by email are preferable but feel free to call with questions as well.

Executive Summary

Vicomsoft have gained extensive knowledge in the use and implementation of DHCP servers.
Vicomsoft would advise the use of DHCP in any environment. The Use of DHCP has many
benefits over alternative configuration methods. It drastically reduces the time to set up client
computers and eliminates the likelihood of configuration errors.

What Is DHCP?

DHCP (Dynamic Host Configuration Protocol) is a protocol that lets network administrators
manage centrally and automate the assignment of IP (Internet Protocol) configurations on a
computer network. When using the Internet's set of protocols (TCP/IP), in order for a computer
system to communicate to another computer system it needs a unique IP address. Without DHCP,
the IP address must be entered manually at each computer system. DHCP lets a network
administrator supervise and distribute IP addresses from a central point. The purpose of DHCP
is to provide the automatic (dynamic) allocation of IP client configurations for a specific time
period (called a lease period) and to eliminate the work necessary to administer a large IP
network .
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Who Created DHCP?

DHCP was created by the Dynamic Host Configuration Working Group of the Internet
Engineering Task Force (IETF: a volunteer organization which defines protocols for use on the
Internet). As such, its definition is recorded in an Internet RFC (standard) and the Internet
Activities Board (IAB) is asserting its status as to Internet Standardization.

Why Is DHCP Important?

When connected to a network, every computer must be assigned a unique address. However,
when adding a machine to a network, the assignment and configuration of network (IP)
addresses has required human action. The computer user had to request an address and then the
administrator would manually configure the machine. Mistakes in the configuration process are
easy for novices to make and can cause difficulties for both the administrator making the error
as well as neighbors on the network. Also, when mobile computer users travel between sites,
they have had to relive this process for each different site from which they connected to a
network. In order to simplify the process of adding machines to a network and assigning unique
IP addresses manually, there is a need to automate the task.

The introduction of DHCP alleviated the problems associated with manually assigning TCP/IP
client addresses. Network administrators have quickly appreciated the importance,
flexibility and ease-of-use offered in DHCP.

How Does DHCP Work?

When a client needs to start up TCP/IP operations, it broadcasts a request for address
information. The DHCP server receives the request, assigns a new address for a specific time
period (called a lease period) and sends it to the client together with the other required
configuration information. This information is acknowledged by the client and used to set up its
configuration. The DHCP server will not reallocate the address during the lease period and
will attempt to return the same address every time the client requests an address. The client
may extend its lease with subsequent requests and may send a message to the server before the
lease expires telling it that it no longer needs the address so it can released and assigned to
another client on the network.

What Advantages Does DHCP Have Over Manual Configuration Methods?

The use of DHCP is highly recommended and there are a number of obvious reasons why you
should use it. As mentioned before, there are two ways you can configure client addresses on a
computer network, either manually or automatically. Manual configuration requires the careful
input of a unique IP address, subnet mask, default router address and a Domain Name Server
address. In an ideal world, manually assigning client addresses should be relatively straight
forward and error free. Unfortunately, we do not live in an ideal world; computers are
frequently moved and new systems get added to a network. Also if a major network resource,
such as a router (which interconnects networks) changes network addresses, this could mean
changing EVERY systems configuration. For a network administrator this process can be time
consuming, tedious and error prone. Problems can occur when manually setting up your client
machines, so if you have the option to set-up your client machines automatically, please do, as
it will save you time and a lot of headaches.
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DHCP has several major advantages over manual configurations. Each computer gets its
configuration from a "pool" of available numbers automatically for a specific time period
(called a leasing period), meaning no wasted numbers. When a computer has finished with the
address, it is released for another computer to use. Configuration information can be
administered from a single point. Major network resource changes (eg. a router changing
address), requires only the DHCP server be updated with the new information, rather than
every system.

Can DHCP Provide Support For Mobile Users?

Yes. The benefits of dynamic addressing are especially helpful in mobile computing
environments where users frequently change locations. Mobile users simply plug-in their laptop
to the network and receive their required configuration automatically. When moving to a
different network using a DHCP server, then the configuration will be supplied by that
networks server. No manual re-configuration is required at all.

Are DHCP Servers Easy To Set-Up And Administer?

DHCP Servers offer completely centralized management of all TCP/IP client configurations,
including IP address, gateway address and DNS address. DHCP servers are easy to administer
and can be set-up in just a few minutes. Client addresses are assigned automatically unlike
static set-up which requires the manual input of client addresses which can be a time consuming
and tedious task.

Are There Any Limitations That I Should Be Aware Of?

Some machines on your network need to be at fixed addresses, for example servers and routers.
The DHCP server you choose should be capable of assigning pre-allocated addresses to these
specific machines.

You need to be able to assign a machine to run the DHCP server continually as it must be
available at all times when clients need IP access.

To avoid conflicts between addresses assigned by the DHCP server and those assigned
manually, users should be discouraged, or preferably prevented, from re-configuring their own
IP addresses.

Some older operating systems do not support DHCP. If you have such systems they may be able
to upgrade them. If this is not possible they may support the older BOOTP protocol and a
DHCP server can be chosen that will support this option.

For peace of mind, it is a good idea to decide what is important to you, which of the available
DHCP servers is best suited to meet your specific requirements and always get a second opinion.

What's The Bottom Line? What Do Vicomsoft Recommend?

Assigning client addresses automatically is by far the easiest option of the two. To set-up
clients to receive their address information automatically all you need to do is to set your
TCP/IP control panels to receive automatically. The DHCP server then assigns the required
client address information.
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If you intend to set up your client computers manually, make sure that the assigned IP address is
in the same range of your default router address and that it is unique to your private network.
However we would highly recommend that if you have a network of computers and the option
to assign your TCP/IP client configurations automatically, please do. An IP address allocation
scheme will reduce the time it takes to set-up client computers and eliminate the possibilities
of administrative errors.
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A AppleScript Commands

About this Appendix

The Vicomsoft DHCP Server now supports AppleScript, this allows the user full control over
the DHCP Server. The DHCP Server supports Apple's Required set of AppleScript Commands:

open: Open the specified object(s)
open alias -- list of objects to open

quit: Quit application
quit

print: Print the specified object(s)
print alias -- list of objects to print

run: Sent to an application when it is
                 double-clicked run

AppleScript, DHCP Server Commands

The DHCP Server now supports the following AppleScript Commands;

GetPortIPAddress: Gets the IP address of the named or indexed port
GetPortIPAddress string -- Name or number of the port to get an IP address for
Result:  string

GetDHCPList: Returns a list of DHCP hardware addresses, usernames and timeouts
GetDHCPList
Result:  list

GetPortList: Returns the list of port names
GetPortList
Result:  list

StopPort: Stops a port
StopPort string -- Name or number of the port to stop

StartPort: Starts a port
StartPort string -- Name or number of the port to start

ResetPort: Resets a port
ResetPort string -- Name or number of port to reset

StartRouting: Starts Serving DHCP
StartRouting

StopRouting: Stops Serving DHCP
StopRouting

GetPortStatus: Gets the current status message for a port
GetPortStatus string -- Name or number of port to get status
Result:  string
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B Legal and
Commercial Matters

Legal Matters

License

The purchase price of the software includes a personal non-exclusive license for the
person/company purchasing the license to use or install the program and associated files for
their own purposes, on ONE Macintosh computer at one time.

The license does NOT include the right to make any copies of the program and files for any
purpose other than backup or to have the program installed on more than one Macintosh at one
time. No copies of all or portions of manuals are to be made. Any copies of software or
installation on more than one hard disk or copies of manuals (or portions thereof) shall
constitute a breach of copyright and shall be dealt with to the fullest extent of the applicable
law.

The word “backup” means a copy for the licensee’s own personal security in the event of failure
of the disks provided by Vicomsoft Technology Limited. The licensee undertakes not to transmit
any copy of his backup to any third party, whether for sale or otherwise. Any such
unauthorized transfer shall constitute a breach of license and copyright.

Should the licensee desire to transfer his license to use the software to a third party, he shall
firstly obtain the consent in writing of Vicomsoft Limited which consent shall not be
unreasonably withheld. Licensees requiring copies of Vicomsoft software to run on multiple
CPUs should contact Vicomsoft to obtain details of quantity discounts and site licenses.

Warranty

Should the supplied disks fail, for reasons of defect in material within 12 months of purchase
and registration, Vicomsoft will replace such failed disk for the Registered Owner free of
charge.

Notwithstanding the above, Vicomsoft shall not replace, or be obliged to replace any disk if it
has failed as a result of misuse.

Disclaimer Fitness For Particular Purpose

Vicomsoft makes no representations or warranties of any kind whatsoever with respect to the
software, or the contents thereof, other than that herein set out and specifically disclaims
warranty for fitness for any particular purpose. Vicomsoft shall not be liable for errors
contained in the software or herein or for incidental or consequential damages in connection
with the furnishing, performance or use of the software or the manuals.

Changes to Software or Documentation

Vicomsoft reserves the right to revise the software and/or the User Guide and to make changes
in the content thereof, without the obligation to notify any person of such changes.
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Trademarks Acknowledged

Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

Apple, the Apple logo, Mac, Mac logo, Macintosh, Power Macintosh and QuickTime are
trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

All trademarks, Service Marks and the like owned or used by third parties and mentioned in
this guide are hereby acknowledged.

Commercial Matters

Technical Support

Vicomsoft shall provide technical support via Email or by telephone, only to bona fide
licensees of Vicomsoft software who have completed, signed and returned their Warranty
Registration forms.

Upgrades

From time to time Vicomsoft issues upgrades to the Vicomsoft software. These upgrades shall
only be available at special discount prices to bona fide licensees of Vicomsoft who have
completed, signed and returned their Warranty Registration forms.

Feedback

Vicomsoft have been creating communications products since 1985. Many people have provided
input which has contributed to the many improvements and enhancements.

Input from users, corporate support departments, VARs and dealers regarding future
improvements and enhancements, is actively encouraged and gratefully accepted.



32

Index
A  

Administrator Console   22
Advantages of DHCP   26
Allow Remote Management   13
Apple Script  

Commands   29
DHCP Server Commands   29

Automatic launch   8
Automatic start   8

B  
Backup copies, non-transferable   30
BOOTP   1
Breach of copyright   30

C  
Can Login   24
Can Manage   24
Clients Scale   10
Connect To...   22

Remote Server   22
Copying  

for backup purposes   30
of manuals, not permitted   30
of software, limited license   30

D  
Default Domain Name   12
Default gateway   12
DHCP   1

Clients File   15
Server   1
Settings   14

DHCP Configuration   21
Windows 2000 Clients   21

DHCP Q&A   25
DHCP Setup  

Automatic Ranges   14
Boot File   14
Boot Server IP   14
Check If Address is Already In Use  
14
Lease time   14
Maximum Clients   14

Disconnect User   7
DNS   2
Domain Name Server See DNS
Snapshot DHCP clients   7

E  
Edit Port Settings  

Port Address   6
Port Name   6
Using   6

Enable DHCP Serving   12
Ethernet   6

F  
Feedback   31

G  
-Gateway- Extension   5

H  
Hops   17
How Does DHCP Work   26

I  
Is DHCP Important   26

L  
Launch State   11

M  
Mac Port   5
MacTCP Config   19
menu   9

DHCP Server   9
Edit   9
File   9

N  
Network   17
Network Preferences  

Enable DHCP Serving   12
Only to client in the ‘DHCP clients’ file  
12, 16

Notices  
changes to software or manuals   30
commercial matters   31
technical support   31
trademarks acknowledged   31
upgrades   31
warranty   30

Subnet Mask   17

O  
On/Off Switch   8, 10
OnlineComms Store   4



Index

33

Only to client in the ‘DHCP clients’ file  
12, 16
Open Transport   5
Open Transport Config   18
Operating the DHCP Server   8

P  
Port  

List   10
Port Address   6
Port Name   6
Preferences   11

General   11
Network   11
Security   11

Preferences, General   11
Active At Application Launch   11
Ask for confirmation   11
Inactive At Application Launch   11
Set Mac Port   11
Show User Interface When Router
Application Launches   11

Preferences, Network  
Default Domain Name   12
Default gateway   12
DNS Address   12
WINS Address   12

Preferences, Security   13
Administration Lock Timeout   13
Administration Password   13
Enable Remote Management   13

Pull-down menus   9
Purchase   4

Q  
Q&A   25
Quantity discounts   30

R  
Remote Management  

Connect To...   22
Remote Users  

Can Login   24
Can Manage   24

Routing table  
hop count   17
manual   17
network   17
subnet mask   17
via gateway   17

S  
Set Administration Lock Timeout   13

Set Administration Password   13
Site Licenses   30
Snapshot DHCP clients   12, 16
Start/Stop   8
Startup Items, System Folder   8
Static Address   6
Status Window  

Condensed View   10
Standard View   10

Status Window   10
Condensed View   10
Standard View   10

Subnet Mask   6
Support   31

only to registered users   31
System Requirements   2

Disk space   2
Hardware   2
Memory   2
Network   2
OS version   2

T  
The Bottom Line   27

U  
Upgrades   31

only to registered users   31

V  
Vicomsoft DHCP Server Users   23

Remote Users   23
View DHCP Clients   7
View Users   7

W  
What is DHCP   25
Who Created DHCP   26
Windows 3.x Config   21
Windows 95/98 Config   20
Windows NT Config   20
WINS Address   12




